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1 Executive Summary
2018 February 15 Update:
Consistent with the 2016 Astrophysics Senior Review, which recommended that Spitzer be
operated until the James Webb Space Telescope is launched
and successfully commissioned, NASA has extended the Spitzer mission
through November 2019. This Call for Proposals solicits the final year of Spitzer
observations and has been updated in response to the mission extension.
This is the FINAL CALL FOR PROPOSALS for observations with the Spitzer Space
Telescope. The Beyond phase of the Spitzer mission is now funded by NASA through November
2019. While Cycle-13 was planned as the last comprehensive proposal call for Spitzer time,
sufficient hours are available to warrant a full Cycle-14 call for proposals. Since the start of the
Beyond mission we have had two structured Director’s Discretionary Time (DDT) proposal
reviews. Cycle-14 takes the place of what was planned as the final structured DDT review. New
science, that could not reasonably be proposed by the Cycle-14 deadline, will continue to be
supported through Director’s Discretionary Time. All other proposals should be submitted in
response to this call. The guidelines are as follows:
1. Up to 6,000 hours of observing time will be selected in Cycle-14. All programs will be
assigned a scheduling priority (1-2) based on the review ranking of the proposal.
Priority 1: 4,000 hours
Priority 2: 2,000 hours
2. Proposals are due: Friday, March 23, 2018, 2pm PDT
3. The primary review criterion is the overall scientific merit of the proposed investigation
and the importance of the program as a component of the final legacy of the Spitzer
mission.
4. Cycle-14 runs from November 1, 2018 – November 30, 2019. Timing constraints for
observations prior to November 1, 2018 must be well justified, as these observations
would delay priority 1 observations already in the scheduling pool.
5. Proposals of any size may be submitted. Prior to proposing, investigators should
understand the visibility windows for their proposed targets.
6. The default proprietary period for all Cycle-14 programs is one year.
7. Generic targets and low-impact target of opportunity observations may be proposed. For
such observations proposers must include a well-defined description of the provenance of
the targets and a proposed schedule for when they will be available.
a. TESS follow-up proposals, utilizing generic targets, may be submitted by any
eligible investigator. If a successful Cycle-14 TESS follow-up proposal includes
investigators from the TESS science team, any targets that the team plans to
observe that are included in the first public data release must be defined at the
1
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time of the release. Definition of the targets is accomplished through the
submission of completed AORs for those targets to the SSC.
8. No joint time with other observatories is available in Cycle-14.
9. Proposals will be reviewed by topical science panels and a Time Allocation Committee in
an in-person review meeting.
10. Proposals must be submitted using the Cycle-14 proposal template and follow the page
limits and other instructions provided in these guidelines.
11. There is no direct data analysis funding available for successful Cycle-14 proposers.

1.1 Cycle-14 Deadlines
The deadlines and milestones for the proposal cycle are listed in Table 1.
Milestone
Update Call for Proposals
Issue Call for Proposals
Proposal Deadline
Announce Results
Cycle-14 Execution

Date
February 15, 2018
December 15, 2017
2pm PDT, Friday, March 23, 2018
May 25, 2018
November 1, 2018 – November 30, 2019

Table 1: Cycle-14 proposal deadlines and milestones.

1.2 Proposal Types
This CP invites investigators worldwide to submit Spitzer Space Telescope Cycle-14 proposals
of all sizes. Sizes and the guidelines for proprietary periods are summarized in §3 and Table 2.
Program Type
Large
Medium
Small
Snapshot

Size
Hours ≥ 100
10 < Hours < 100
Hours ≤ 10
Hours < 100

Default Proprietary Period
1 year
1 year
1 year
1 year

Table 2: The definition of the program types, sizes and default proprietary periods.

1.3 Available Observing Time & Scheduling Priorities
The Cycle-14 Time Allocation Committee (TAC) will be asked to recommend to the SSC
Director up to 4,000 hours of priority 1 science and 2,000 hours of priority 2 observations to
facilitate efficient scheduling of the observatory. The scheduling priority (1 or 2) assigned to the
selected programs will be primarily based on the TAC ranking and the program’s responsiveness
to the selection criteria outlined in §7.2.
The project will make every effort to schedule all priority 1 observations but cannot guarantee
execution. Priority 2 observations will be placed in the scheduling pool as gaps develop.
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1.4 Observing and Data Volume Constraints
All proposals (see limitations for Snapshot programs, §3.3) can include observations that are
constrained, with the caveat that the more constrained the program, the harder it is to schedule.
Though the project has implemented enhanced data compression strategies, data volume is a
limiting factor due to the downlink rate, as Spitzer is more than 1.6 au from the Earth. Very high
data volume proposals are not prohibited but will be executed only in extraordinary
circumstances. Table 3 summarizes the observing modes, frame times and a rating of the
expected data volume. If your observation requires a ‘very high’ data volume mode, please
consult with the SSC before you submit your proposal to determine the feasibility of your
proposed observation.
Mode
Full-array
Full-array & HDR
Full-array & HDR
Sub-array
Sub-array
Sub-array

Frame Time (secs)
0.4, 2
6, 12, 30
100
0.02, 0.1
0.4
2

Data Volume
Very High
Moderate
Low
Very High
Moderate
Low

Table 3: The Data Volume Ratings for the available observing modes and frame times. These ratings apply
to data taken with “data collection” turned on for one or both arrays.

1.5 Programs not available in Cycle-14
1. Archival Research (AR) or Theoretical Research (TR) programs are not available through this
call for proposals. NASA supports AR and TR science through other programs (see NASA
Research Opportunities in Space and Earth Sciences - ROSES).
2. High- and medium-impact ToO observations are not supported in warm mission GO
proposals. They may be requested via Director’s Discretionary Time (§3.7).
3. The 200-second frame time for IRAC full-array observations is not supported. The maximum
supported frame time is 100 seconds.

3
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2 Mission Overview
This section briefly summarizes the scientific capabilities of the Spitzer Space Telescope. The
reader is urged to consult the companion document, the Spitzer Space Telescope Observer’s
Manual-Warm Mission (Warm SOM, hereafter), for complete technical details of the telescope
and the IRAC instrument. The Warm SOM is available in the Proposal Kit section of the Spitzer
Science Center (SSC) website (http://ssc.spitzer.caltech.edu/warmmission/propkit/).
The Spitzer Space Telescope is the fourth and final element in NASA’s family of Great
Observatories and represents an important scientific and technical component of NASA’s
astrophysics program. The telescope was launched from Cape Canaveral, Florida into an Earthtrailing heliocentric orbit on August 25, 2003. The Spitzer primary mirror is 0.85 meters in
diameter. After the cryogen was depleted on May 15, 2009, the 3.6- and 4.5-micron IRAC arrays
continued to be operational. The telescope operates at an ambient temperature of 27.5 K. Warm
mission science observations began on July 28, 2009 after a characterization period of the IRAC
instrument and Warm Mission astronomical observation template (AOT). Observatory
performance is excellent and basically unchanged from the cryogenic mission.

2.1 Telescope
The Spitzer telescope is of Cassegrain design, with beryllium optics, and operates during the
warm mission at ambient temperature (27.5 K). The telescope offers pointing accuracy of better
than 1.0 arcsec (1-sigma radial rms), and pointing stability of 0.1 arcsec (1-sigma radial rms, 200
sec) with the star-tracker. The imaging field-of-view is ~5 arcmin square. Spitzer is capable of
achieving tracking rates of ~1 arcsec/sec for fast-moving (e.g., Solar System) targets.

2.2 Orbit/Sky Visibility
The Spitzer Space Telescope is in an Earth-trailing heliocentric orbit with radius 1 au, and is
drifting away from Earth at a rate of about 0.1 au per year. In this orbit, the telescope is in a
benign thermal environment. Moreover, this choice of orbit substantially reduces the projection
of the Sun-Earth-Moon avoidance zones on the sky, yielding high astronomical observing
efficiencies.
The telescope’s instantaneous visibility region is a 37.5-degree wide annulus, extending from
82.5° to 120° in solar elongation, and encompassing all ecliptic latitudes. The size of this region
is constrained in two ways. First, the telescope cannot point within 82.5 degrees of the Sun, for
reasons of thermal control. Second, the telescope cannot point more than 120 degrees from the
Sun (except for downlinks), in order to maintain sufficient illumination of the power-generating
solar panels and for thermal control. About one-third of the entire sky is accessible to Spitzer at
any given time. The visibility and observing constraints are basically unchanged in the warm
mission with respect to the cryogenic mission.
The amount of time that any particular target is visible to Spitzer is a function of ecliptic latitude.
Objects with |ecliptic-latitude| > 82.5° are located within the CVZ, and those with 60° < |eclipticlatitude| < 82.5° are annually visible to Spitzer in one continuous ~7-month time interval.
Targets with |ecliptic-latitude| < 60° are observable twice per year in ~40-day windows. For any
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given target position, sky visibility is available using Spot, Spitzer’s observation planning
software (§4.2).

2.3 Science Payload
In the warm mission, the Spitzer Space Telescope science payload consists of the InfraRed Array
Camera (IRAC) 3.6- and 4.5-micron channels. The IRAC arrays are thermally controlled to
28.7 K and the temperature is stable to 10 mK (the precision of the temperature sensors). In
addition to the temperature set points, several of the programmable biases for the 3.6- and 4.5micron arrays were optimized for warm operations. Most significantly, the applied bias across
the 3.6-micron array was reduced from 750 mV to 500 mV to mitigate the increased number of
noisy pixels at the higher operating temperature. The arrays exhibit both bias and photometric
stability consistent with cryogenic performance and demonstrate no significant radiation-induced
damage at the higher operating temperature.
Warm IRAC provides simultaneous ~5 arcmin square images in two channels ( λ / Δλ ~ 4)
centered at 3.6 microns (Channel 1) and 4.5 microns (Channel 2). The 256 x 256 pixel focalplane arrays use Indium Antimonide (InSb) detectors. The pixel scale for each detector array is
~1.2 arcsec/pixel. Two nearby fields of view (FOV) are simultaneously imaged, with Channel 1
comprising one FOV, and Channel 2 the other FOV. The Principal Investigator for IRAC is
Giovanni G. Fazio, Smithsonian Astrophysical Observatory, Harvard-Smithsonian Center for
Astrophysics.

2.4 Warm Mission Observing Mode
Observations are executed with one observing mode – IRAC Post-Cryo Mapping. Observers
completely specify their observations through the use of an Astronomical Observation Template
(AOT). The complete specification of targets and observing parameters is done using Spot, the
software for Spitzer observation planning. The AOT in Spot provides observers with control of
all the relevant parameters for their observation. An AOT with target information and observerselected parameters specified becomes an Astronomical Observation Request (AOR), the
fundamental unit of Spitzer observing. Details about observing with IRAC and the available
choice of AOT parameters are provided in the Warm SOM.
The maximum duration for warm IRAC AORs is 24 hours, BUT since instrument and
observatory calibrations generally occur every 12 hours, only when the science requires longer
uninterrupted on-source time should AOR durations exceed 6-8 hours. AOR durations longer
than this must be justified in the proposal.

2.4.1 Special Observing Modes - IERs
In special circumstances, observations that cannot be supported with the warm IRAC AOT have
been executed with Instrument Engineering Requests (IERs). Please consult with the SSC well in
advance of submitting a proposal that requires IERs. Long staring observations that in the past
used IERs (e.g. extrasolar planets) should now use AORs with a PCRS Peak-Up.
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2.4.2 High-Precision Photometry Observations
The IRAC Instrument Support Team has created a website that presents the IRAC team’s best
understanding of how to plan, execute, and analyze high-precision photometry observations.
Please consult http://irachpp.spitzer.caltech.edu for the latest recommendations.

2.5 Observation Scheduling
Observations are scheduled with interruptions for downlinks every 24 – 48 hours. Interruptions
for quick turn-around (high/medium impact) target of opportunity observations will be supported
only through DDT (§3.7). Low-impact ToO observations with at least an 8-week lead-time can
be supported through the proposal process (or through DDT).

2.6 Science Operations
An integrated team of personnel from the Jet Propulsion Laboratory (JPL), Lockheed Martin
Space Systems Company (Denver) and the Spitzer Science Center (SSC) conducts flight
operations for Spitzer. Science operations activities are based at the SSC, on the campus of the
California Institute of Technology, Pasadena. The SSC solicits research investigations through
Calls for Proposals; organizes the peer review of the proposals by science experts; and
administers supporting NASA research funds for investigations selected by the SSC Director. In
addition, the SSC schedules all science observations (including instrument and spacecraft
calibrations), conducts pipeline processing of all Spitzer Space Telescope data, places the data in
the electronically accessible science data archive and provides science user support to the
community through the Helpdesk.
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3 Proposal Categories
Please consult with the SSC Helpdesk (help@spitzer.caltech.edu) in advance of the proposal
deadline if you have questions about AOR submission for your proposals.
The default proprietary period for all Cycle-14 proposals is one year.

3.1 Small & Medium General Observer Proposals
Small and Medium GO proposals must meet the following criteria:
•
•
•

Small: 10 hours or less of observing time requested.
Medium: Greater than 10 hours and less than 100 hours of time requested.
A full set of AORs must be submitted with the proposal.

3.2 Large General Observer Proposals
Large GO proposals must meet the following criteria:
•
•

100 hours or more of observing time requested.
Sample AORs must be submitted with the proposal.

3.3 Snapshot Proposals
Snapshot proposals are solicited in Cycle-14. Snapshot programs are needed to provide easy to
schedule, lower data volume science that can fill gaps in the observing schedule introduced by
highly constrained observing programs.
Snapshot programs have the following specific features:
1. The restriction on ‘no scheduling constraints’ for Snapshot programs was relaxed in
Cycle-12. Loose grouping constraints can be supported, e.g. two epochs of each target
are desired greater than 3 weeks apart.
2. For filling typical schedule gaps the ideal AOR length is ~ 30 minutes or less.
3. The maximum single AOR length is ~ one hour.
4. Allowed frame times are full-array/HDR = 100 sec and sub-array ≥ 0.4 sec
5. Snapshot programs are assigned scheduling priority 2.
6. Distribution of Targets:
a. Programs with targets in or near the CVZ (see §2.2) are most desirable.
b. Programs with targets spread throughout the sky can also be supported.
7. Snapshot proposals should be < 100 hours and follow the small/medium GO page limits.
A full set of AORs must be submitted with the proposal.
If you are uncertain if your proposed program is appropriate as a Snapshot proposal, please send
questions to the SSC Helpdesk (help@spitzer.caltech.edu) well in advance of submitting the
proposal. The total time requested on the cover sheet for Snapshot proposals should be the total
for the AORs submitted, not the 50% expected to be executed.
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3.4 Statistical Programs
Statistical programs, where a specific number of observations are required for the science but the
set of observations required is not unique, may be submitted. For example, if your program
requires observations of 100 targets and you have 200 targets total in the sample, the proposal
can be submitted with AORs specifying observations of 200 targets but time is only requested to
observe 100 of them. This should be clearly described in the technical justification section of the
science plan.

3.5 Targets of Opportunity
Observations of phenomena whose exact timing and/or location on the sky are uncertain at the
time of the proposal submission deadline (e.g., newly discovered comets or near-earth asteroids,
weather patterns on outer planets, gamma ray bursts and other transients) are typically submitted
as General Observer Target of Opportunity (ToO) proposals. ToO observations classified as
low-impact ONLY (see below) can be requested.
Targets of Opportunity are categorized by the extent to which the execution of such an
observation affects normal scheduling and observing procedures. A low-impact ToO is one
where the time between triggering the ToO and the execution of the observations is longer than
eight weeks. There is no limit on the number of these low-impact ToO observations that can be
approved.
Observations of unanticipated phenomena should be requested through Director’s Discretionary
Time (DDT) procedures (see §3.7). High/medium impact ToOs must be requested via DDT
proposals. The Spitzer project can potentially support one high/medium impact ToO in
Cycle-14 as permitted by available resources. Additional overheads are assessed for
high/medium-impact Targets of Opportunity and are described in Appendix A.
An approved ToO observation will be executed only in the event that the specified phenomenon
actually occurs within the Cycle. Additional information on Targets of Opportunity, including
the procedures for activation of an approved AOR, can be found in the Spitzer Warm Mission
Observing Rules (http://ssc.spitzer.caltech.edu/warmmission/propkit/sor/).

3.6 Generic Targets
Generic targets have more refined and predictive spatial and temporal information than a ToO.
Generic targets can be described scientifically, but lack precise celestial coordinates or
brightness estimates at the time of the proposal submission deadline. A generic target can be
selected from a complementary observing program with Spitzer, or with any other telescope, but
one in which the conditional observations (assumed to be under the control of or clearly
available to the Spitzer Principal Investigator) are scheduled or will be scheduled with high
likelihood, but have not been executed or analyzed prior to the Spitzer proposal deadline.
Studies of newly discovered extra-solar planets or targets from large surveys that have yet to be
released are examples of such science categories.
TESS follow-up proposals, utilizing generic targets, may be submitted by any eligible
investigator. If a successful Cycle-14 TESS follow-up proposal includes investigators from the

8

Spitzer Cycle-14 Call for Proposals

v2.0

15 February 2018

TESS science team, any targets that the team plans to observe that are included in the first public
data release must be defined at the time of the release. Definition of the targets is accomplished
through the submission of completed AORs for those targets to the SSC.
An investigator may propose observations of generic targets, describing them in as much detail
as possible in the proposal. For a moving generic target (e.g., Solar System object) proposers
must submit an AOR with a target position ‘to be determined’ from Navigation and Ancillary
Information Facility (NAIF) identification, or from orbital elements and the AOR duration must
be specified to within a factor of 1.5. Examples of generic moving targets can include near-Earth
asteroids, main-belt asteroids, comets, and Kuiper Belt Objects. Because of the time urgency
of observations, comets near perihelion should be treated as Targets of Opportunity.
The observations must be completed within the observing time allocation awarded when the
proposal was approved. Examples of generic targets and additional details and limitations
pertaining to their use can be found in the Spitzer Warm Mission Observing Rules
(http://ssc.spitzer.caltech.edu/warmmission/propkit/sor/).
Generic targets must be defined and final AORs submitted to the SSC as soon as feasible so
that they have the maximum likelihood of being scheduled. Please contact the Helpdesk
before submitting your proposal if you have questions regarding generic targets.

3.7 Director’s Discretionary Time
New science, that could not reasonably be proposed by the Cycle-14 deadline, will continue to
be supported through Director’s Discretionary Time. All other proposals should be submitted in
response to this call. Details about submitting DDT proposals are available in the Spitzer
proposal kit at http://ssc.spitzer.caltech.edu/warmmission/propkit/.
Abstracts of approved DDT proposals are also available at the SSC website. Investigators should
not utilize DDT to resubmit all or part of a proposal that was previously rejected.

3.8 Data Proprietary Periods
The default proprietary period for all Cycle-14 programs is one year. The proprietary period
commences when scientifically usable data from commissioned pipelines are made available to
the Principal Investigator via the Spitzer Heritage Archive. Once the proprietary period for an
AOR expires, the raw and pipeline-processed data enter the public domain and are available to
anyone through the Spitzer Heritage Archive.
Note that each observation (AOR) has its own proprietary period. This means that the AORs
within a program are, as their proprietary periods expire, released to the public regardless of
how many unobserved AORs remain in the program.
For observations with a proprietary period, observers expect exclusive access to their science
data, intended to facilitate the processing and scientific analysis of the data by the relevant
investigator. The SSC does not have the resources to do duplication checks or embargo data from
duplicating observations in the warm mission. Therefore, the SSC cannot ensure that all
9
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proprietary periods will be protected for observations taken in Cycle-5 onwards. DDT proposals
have a nominal proprietary period of 0 days, though up to 90 days may be proposed. The SSC
Director reserves the right to designate any Target of Opportunity or DDT data for early release
when such a release is deemed to be in the interest of the community. The Spitzer Time
Allocation Committee and reviewers may recommend a shorter proprietary period for individual
proposals due to the high value of the data to the general astronomical community. As part of
their proposal, observers may request that the SSC Director waive all or part of their proprietary
period if the proposal is approved. This information should be provided in the coversheet
information in the Spot proposal submission tool.

4 Proposal Planning
This call for proposals (CP) provides an overview of the technical capabilities of the observatory
(§0), eligibility criteria (§6), the current research opportunities (§3) and information on planning
and submitting a proposal (this section). The CP is accompanied by other technical documents
(§4.1). Interested scientists may retrieve digital copies of these documents from the Proposal Kit
section of the Spitzer Science Center (SSC) website
(http://ssc.spitzer.caltech.edu/warmmission/propkit/). An important component of the Proposal
Kit is Spot, the Spitzer software required for observation planning and proposal submission. All
Cycle-14 proposals must be submitted with Spot, a free software package available now
within the online Proposal Kit. Spot must be downloaded to your computer.
In addition to handling proposal submission, Spot allows observers to construct detailed
Astronomical Observation Requests (AORs) by specifying observation parameters for the
required observing mode. The observing mode IRAC Post-Cryo Mapping is available in Spot to
support warm operations. Spot also includes useful visualization tools to permit the investigator
to see how proposed Spitzer observations will be laid out on the sky.
Questions pertaining to the current CP should be sent electronically to the Spitzer Helpdesk at
help@spitzer.caltech.edu. Questions (and answers) that are deemed by the SSC to be of broad
interest to Spitzer investigators are listed in the Frequently Asked Questions section of the SSC
website.
Before submitting a Spitzer Space Telescope proposal, it is important that investigators consult
relevant technical documentation about the capabilities of the telescope, the sensitivities of the
IRAC instrument and the nature of the pipeline-processed data delivered to investigators by the
SSC. Proposals must include credible and justifiable estimates of requested observing time.
Spot, the Spitzer observation planning and proposal submission software, and other online
resources are provided for this purpose. All of these resources may be found within the Proposal
Kit section of the SSC website (http://ssc.spitzer.caltech.edu/warmmission/propkit/).
The documentation listed in §4.1 provides details on how researchers can learn about the
capabilities of Spitzer, plan and define their detailed observational program, check for possible
duplicate observations, and modify their planned observations. Specific questions should be
submitted electronically to the Helpdesk at help@spitzer.caltech.edu.
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A Cycle-14 proposal requests Spitzer Space Telescope observing time and consists of these
elements:
• A scientific justification for the program.
• A technical plan describing how the scientific investigation will be implemented,
including an explanation of target selection and observing strategy, and how the data will
be analyzed.
• Detailed specification of Spitzer observations, through Astronomical Observation
Requests (AORs) generated by Spot. Only AORs utilizing the IRAC Post-Cryo Mapping
Astronomical Observation Template (AOT) will be accepted.

4.1 Technical Documentation
The documents needed to plan, prepare and submit a proposal are listed below and are available
in the Proposal Kit (§4.2). The version numbers are current as of the date of publication of this
CP and may be superseded by a later version.
Spitzer Space Telescope Cycle-14 Call for Proposals (CP)
The Call for Proposals is the present document.

Version 2.0 (Feb. 15, 2018)

IRAC High Precision Photometry website
http://irachpp.spitzer.caltech.edu
All information related to best practices and recommendations for planning and analyzing
high precision photometry observations is now provided on this website. Consult the ‘What’s
New’ section for the latest updates.
Spitzer Space Telescope Warm Mission Observing Rules Version 2.2 (September 17, 2014)
The Observing Rules describe the rules and processes governing duplicate observations,
the declaration and modification of AORs, and other policies governing Spitzer observations.
Spitzer Space Telescope Observer’s Manual-Warm Mission Version 12.1 (July 19, 2013)
The Spitzer Observer’s Manual-Warm Mission (Warm SOM) provides technical
information about the telescope and the IRAC Instrument. It includes information on planning,
editing and submitting Astronomical Observation Requests (AORs), the user-provided
specification of individual observation parameters. The Warm SOM is an essential document for
all investigators. http://ssc.spitzer.caltech.edu/warmmission/propkit/som/
IRAC Instrument Handbook
Version 2.1.2 (November 2015)
The IRAC Instrument Handbook is the primary reference for planning and analyzing
observations using IRAC.
http://irsa.ipac.caltech.edu/data/SPITZER/docs/irac/iracinstrumenthandbook/
Spot User’s Guide
Spot version 19 (September 2011)
The Spot User’s Guide is a comprehensive guide to the Spitzer observation planning
software package (see §4.2). All proposals must be submitted using Spot.
Leopard User’s Guide
Leopard version 19 (June 2008)
Leopard is the primary tool that proposers should be using to search the contents of the
Reserved Observations Catalog (ROC). Data downloads via Leopard were deactivated on
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November 4, 2010. All users should use the Spitzer Heritage Archive for obtaining Spitzer data.
(http://sha.ipac.caltech.edu/applications/Spitzer/SHA/)
Spitzer Space Telescope Reserved Observations Catalog (ROC) Version 19.0 (Feb. 1, 2018)
The Reserved Observations Catalog includes an itemized list of all executed and
approved observations. Proposers should use Leopard or Spot to query for executed or approved
observations. The ROC is also available online in ASCII text format.
(http://ssc.spitzer.caltech.edu/warmmission/propkit/roc/)
Spitzer Space Telescope Observation Planning Cookbook Version 10.0 (April 17, 2013)
The Observation Planning Cookbook provides detailed examples of how to construct
Spitzer observations. http://ssc.spitzer.caltech.edu/warmmission/propkit/cookbook/
Solar System Observing with Spitzer
Version 6.1 (September 11, 2014)
This webpage provides helpful tips and a summary of information specifically related to
observing objects in our Solar System. http://ssc.spitzer.caltech.edu/warmmission/propkit/sso/

4.2 The Proposal Kit
The online Proposal Kit is the web page that provides all of the information necessary for the
prospective General Observer (GO) researcher. It includes each of the documents listed in §4.1
and can be found on the SSC website (http://ssc.spitzer.caltech.edu/warmmission/propkit). The
reader is urged to consult the SSC Website for the latest observatory news.
The Kit also includes instructions for installing Spot, the Spitzer observation-planning tool, on
the user’s host machine. Spot is used to plan and prepare observations, and to submit all
proposals electronically to the SSC. It allows observers to construct and edit detailed
Astronomical Observation Requests (AORs) by selecting from a variety of preset instrumentspecific functions. Spot also includes useful visualization tools to permit the investigator to see
how proposed observations will be laid out on the celestial sky. These capabilities allow users to
retrieve relevant images from other astronomical surveys and archives. It also describes how an
investigator can obtain estimates of observing time for a proposed program.
Spot requires JAVA version 1.6 or 1.7. It does not work with version 1.8. Prospective GO
investigators are strongly encouraged to download Spot and to start planning their
observing programs well before the proposal submission deadline. Allow Spot to autoupdate to the latest version (Options => Use Automatic Spot Version Update), if you have
not already. If you use Linux and JAVA version 1.8, we recommend you download Spot
for Linux from the Proposal Kit webpage and do a clean re-install, then let Spot autoupdate (Spot Main Toolbar: Options -> Use Automatic Spot Version Update).
Spot allows prospective investigators to plan, develop and modify their proposal in an iterative
manner. That is, a proposer can write a portion of their proposal and define their accompanying
AORs, save the results locally, and then re-load those results at a later time for subsequent
modification. The saved cover sheet information, proposal text and AORs can be modified
repeatedly until the proposal is submitted to the SSC. The submitted proposal can be updated at
any time before the proposal deadline.

12

Spitzer Cycle-14 Call for Proposals

v2.0

15 February 2018

A separate section of the online Proposal Kit contains information specifically designed for Solar
System researchers. It includes asteroid count estimates and tips for utilizing the HORIZONS
database supported by the Solar System Dynamics Group at the Jet Propulsion Laboratory.

4.3 Solar System Observations - Moving Target Ephemerides
Spitzer is capable of achieving tracking rates of ~1 arcsec/sec for fast-moving (e.g., Solar
System) targets. The online Proposal Kit (http://ssc.spitzer.caltech.edu/warmmission/propkit/)
contains a section specifically designed to support Solar System researchers. It includes asteroid
count estimates and tips for utilizing the HORIZONS database supported by the Solar System
Dynamics Group at the Jet Propulsion Laboratory.
To obtain an accurate estimate of the observing time required for your moving target
observation, an ephemeris file for your target must be installed at the SSC. Spot can query the
HORIZONS database at JPL for an ephemeris file if the SSC does not have the file installed
locally. Spot will do this when you do a visibility calculation or calculate resource estimates.
There is a slightly longer delay (on the order of ~5 seconds during ‘normal’ periods) for this
transaction to occur. As with all internet-based resources, there are likely to be peak demand
periods and times when the resource is not available due to unforeseen events. Proposers are
encouraged to start early in planning their observations.
We note also that ephemerides can have large intrinsic errors, and the ensuing positional errors
can be sufficiently large that the object has a very low probability of being acquired by Spitzer.
We therefore strongly recommend that the observer check the available positional accuracy for a
Solar System target before proposing to observe it with Spitzer. Instructions on how to do this
can be found in the Horizons documentation in the Solar System section of the online Proposal
Kit at the SSC website (http://ssc.spitzer.caltech.edu/warmmission/propkit/sso).
Late ephemeris updates, i.e., specification of the final ephemeris less than 5 weeks prior to
scheduling, are no longer supported in GO proposals. Any observations requiring a late
ephemeris update must be submitted via a DDT proposal.

4.4 Additional Guidelines for Observers
This section contains additional guidelines and policies that investigators must know as they plan
their observing proposal.

4.4.1 Duplicate Observations
In general, duplicate observations with the Spitzer Space Telescope are not permitted. It is the
responsibility of the investigator to avoid the duplication of previously approved observations.
A list of all such observations is available in the Reserved Observations Catalog (ROC).
Quantitative descriptions of what constitutes a duplicate observation can be found in the Spitzer
Space Telescope Warm Mission Observing Rules
(http://ssc.spitzer.caltech.edu/warmmission/propkit/sor/). Because of resource limitations in the
warm mission, the SSC will not identify such duplications. Approved observers that identify
potential duplications should submit these to the SSC, where the potential duplication will be
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reviewed and acted upon accordingly. For example, if the duplicating observation has not yet
been executed it may be deleted from the program. In cryogenic cycles, approved duplicate
observations were generally embargoed until the proprietary period of the prior observation
expired. Due to resource limitations, this is not done during the warm mission.

4.4.2 Constrained Observations
If your program requires scheduling constraints to achieve your science goals, apply the
minimum number of constraints needed for your science and provide a clear justification in the
proposal. Contact the Helpdesk early in your planning process for advice on how to best utilize
scheduling constraints. As a rule of thumb any constraint that involves a time range should be at
least twice as long as the AORs you want scheduled within the time range. For example, if you
have 10 hours of mapping AORs, any timing or grouping constraints should allow a minimum of
20 hours for their execution. Observing constraints must be specified in Spot.

4.4.3 Calibration Observations
The SSC establishes and maintains the calibration of the science instrument to levels specified in
the Warm SOM. Data resulting from these routine calibrations will generally enter the Science
Archive upon processing and validation by the SSC.
The initial on-orbit calibration of the telescope was performed as part of the commissioning of
each observing mode. The IRAC Post-Cryo Mapping AOT was validated during the
characterization phase after the depletion of the cryogen. The SSC continues to conduct the
periodic observations necessary to maintain the calibration. Observations of celestial targets
necessary for calibration are not subject to rules regarding duplicate observations.
For investigations that require a higher level of calibration, it is the responsibility of the Principal
Investigator to include those special calibrations as part of their proposal. The SSC will process
such observations through its normal data processing pipeline(s), and the data will be subject to
the applicable proprietary data periods (§3.8). Observers are encouraged to contact the SSC to
discuss and plan special calibrations for those programs requiring a higher level of calibration.

4.4.4 Bright Object Observations
Given the high sensitivity of Spitzer, bright objects can affect the detector arrays. While
saturation will not permanently damage the detector arrays, latency effects can compromise
subsequent observations.
Proposals that involve observations of bright sources are not precluded. However, investigators
should be aware of infrared sources that may saturate the Spitzer detectors, whether they are the
intended target, or whether their celestial position is near the proposed target. They can also
complicate scheduling in our effort to prevent observations of bright targets from impacting
other programs. Programs with substantial numbers of bright targets
(http://ssc.spitzer.caltech.edu/warmmission/propkit/som/brights) will be identified as
difficult to schedule by the SSC, and their evaluation will be affected accordingly.
The Warm SOM provides current estimates of the saturation limits for each wavelength and
frame time. A list of bright celestial sources likely to exceed the saturation limits is provided in
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the online Proposal Kit. Spot also has a bright object search feature to check for bright objects
near your target(s). Note that the SSC reserves the right to exclude some targets as a result of
impacts that these bright objects might have on subsequent observations. Observers proposing
observations of bright objects should discuss their impact in the technical justification.

4.5 SSC Assistance
All questions of a scientific, technical, programmatic or financial nature should be submitted
electronically to the Spitzer Science Center Helpdesk (help@spitzer.caltech.edu). The SSC is
committed to answering all questions as rapidly as feasible, and normally within two business
days from the receipt of a query. Note that as the proposal deadline approaches, the turnaround
times for an SSC response (particularly for definitive answers to complex technical questions)
will likely increase. It is the responsibility of proposers to take this reality into consideration
when submitting queries shortly before the proposal submission deadline.
Questions and answers deemed by the SSC to be of interest to the broader community will be
archived as an anonymous Frequently Asked Question (FAQ) on the SSC website. Therefore, all
questions and comments submitted to the Helpdesk become the property of the SSC and
California Institute of Technology.
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5 Proposal Submission
The Spitzer Cycle-14 submission process is one phase for proposals requesting < 100 hours.
Investigators proposing < 100 hour programs are required to submit all of their completed AORs
with their science proposal (unless the proposal includes generic targets or ToOs). These AORs
should be the final set you expect to have executed if the proposal is successful.
The submission process is two-phase for proposals requesting 100 hours or greater and proposals
including generic targets or ToOs. Investigators must submit representative AORs that clearly
define the proposed observations. The proposal must include complete target lists and
descriptions of the proposed observations. The AORs for successful proposals with defined
targets will be due approximately a month after the selections are announced.
All proposals must be submitted through Spot, a downloadable software package developed by
the SSC. The AORs and cover sheet information are entered directly into Spot for transmittal.
The science justification and all other required elements must be submitted as a single PDF
file attachment. The AORs and cover sheet information created in Spot can be saved as text files
on your local computer. The cover sheet information, the proposal PDF file and the AORs are all
submitted electronically via Spot. Cycle-14 proposals must be submitted with the S19 (or later)
versions of Spot which is available to download from the Proposal Kit website.

** Proposal PDF files must be prepared with the SSC-provided
Cycle-14 templates that are available in the proposal kit.
There is no limit to the number of proposals that may be submitted by a Principal Investigator or
by Co-Investigators. Proposals should not contain classified information or depend on access or
use of classified information or facilities for any portion of the proposed activities. The Principal
Investigator may withdraw a proposal from consideration at any time prior to the completion of
the selection process by contacting the Helpdesk (help@spitzer.caltech.edu).
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5.1 Proposal Submission Deadlines
The proposal submission deadline is the same for all proposals:

Friday, March 23, 2018, 2:00pm PDT
Proposals must be submitted electronically via Spot prior to the deadline. The Spot proposal
submission system is open. Proposals received after the deadline will not be accepted. If you
need information from a source outside of the SSC that you do not directly control, particularly a
service available via the Internet, then we recommend obtaining this information well in advance
of the deadline. You may update your submitted proposal as many times as you want prior to the
deadline. If the SSC servers have started (or completed) processing of your proposal when the
deadline is reached, the proposal will be accepted.

If you experience computer or Internet problems just prior to the
deadline such that you are not able to submit your proposal by 2:00 pm,
send an email to the Helpdesk if possible (help@spitzer.caltech.edu) or
call us immediately at 626-395-8000 (SSC central phone line) so that we
can assist you.
5.2 Proposal Components
5.2.1 Cover Sheet
For all proposals, the Cover Sheet information is entered into Spot and then submitted
electronically to the SSC. This information can be saved to your local computer as a text, PDF or
html file. We recommend that all proposers start early. You can update the cover sheet
information from Spot as many times as necessary prior to the proposal deadline.

5.2.1.1 Science Category
An important piece of information that is provided in the Cover Sheet is the Science Category.
All proposals must include a single science category. This information is used to help distribute
the proposals to the panels for the review. Please select the science category that best describes
your proposal. The categories are divided into three broad groups: Extragalactic, Galactic and
Solar System. The Solar System group is for observations in our Solar System. If your proposal
is related to extra-solar planets, please select that in the Galactic group. The Galactic group
includes a category for proposals that are doing detailed stellar studies outside of our Galaxy.
These proposals have historically ended up in extragalactic panels while the best expertise to
review them is in the Galactic panels.
Broad topical science panels or individual external reviewers will review all proposals. The panel
review will utilize parallel panels so that proposers can serve as reviewers.
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5.2.2 Astronomical Observation Requests (AORs)
Proposals requesting < 100 hours must be accompanied by a complete list of Astronomical
Observation Requests (AORs). For statistical programs (§3.4) this should include AORs for all
possible targets. The submitted AORs should be the final ones you expect to have executed if the
proposal is successful. All other proposals must submit representative AORs that fully
encompass the proposed observations.
All AORs are created in Spot and submitted electronically to the SSC. The AORs that you have
loaded in Spot at the time you are submitting your proposal are the AORs that will be transmitted
to the SSC and stored in our database. Do not include the AORs as text in the proposal PDF file.
You can create or edit your AORs in Spot at any time prior to submitting or updating your
proposal. They can be saved as an ASCII text file on your local computer and then reloaded for
editing or submission at a later time. The AORs include the total time required to execute a given
observation with the telescope. Each AOR includes an assessed overhead of 210 seconds to
account for the average time required to acquire the target, regardless of the actual time
utilized. The average acquisition time is based on our experience to date. Each moving target
AOR is assessed an additional 300 seconds (510 seconds total) overhead per AOR. Moving
target AORs require an additional 5 minutes to execute compared to an identical fixed target
AOR.
Providing robust, ready-to-execute AORs with your proposal is the fastest way to ensure that
your observations get quickly into the scheduling pool. Successful proposers will not, in
general, have any opportunity to make major modifications (see the Spitzer Space Telescope
Warm Mission Observing Rule) to their AORs after selection. Proposers are urged to
carefully plan and construct the AORs that accompany their proposal. AORs submitted
with the proposals can be updated at any time prior to the proposal submission deadline.

5.2.3 PDF Attachment
Templates in Latex and Microsoft Word formats are provided on the SSC Proposal Kit web page
(http://ssc.spitzer.caltech.edu/warmmission/propkit/) and MUST be used to prepare your PDF
attachment.

The Cycle-14 templates must be used to prepare your proposal.
Additional details pertaining to proposal contents are listed in §5.4. All proposals must be written
in English and a printable version must utilize fonts that are no smaller than 12 point, and must
adopt one-inch margins on all sides on 8.5 ´ 11-inch paper. Color figures or tables can be
included but proposers should confirm that they reproduce legibly in black and white. The PDF
file size limit for submission is 10 megabytes, so extremely large or complex color figures may
not be acceptable. No preprints or reprints should accompany the proposal, as they will not be
forwarded to the review panels.
All investigators should recognize that the peer review process (§0) utilizes external scientists
organized into topical Review Panels. A given Review Panel will necessarily span a wide variety
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of research disciplines. Therefore, proposals should be written for a knowledgeable, but broadbased, audience. The science category you select in Spot to characterize the science in your
proposal will determine which panel or set of external reviewers reads it. Proposals will be
evaluated according to the criteria listed in §7.2. Providing more figures+tables and less text is
often viewed favorably by the reviewers.
Proposals will be provided to each reviewer as PDF files. It is the responsibility of the proposer
to ensure that their PDF file is legible when opened with Acrobat Reader other PDF viewers.
Proposals with flagrant violations of the page limits, font size, etc. will be deemed not responsive
to the Call for Proposals and rejected without review.

5.3 Proposal Page Limits
The page limits for Cycle-14 proposals are summarized in Table 4. The descriptions of what
should be included in each section are provided in §5.4. Figures and tables can be embedded in
the narrative or segregated. Do not include any additional material, e.g., letters of endorsement.
Proposal(Size
Small
Medium
Science(Plan(Sections
hours&≤&10
10&<&hours&<&100
Science&Justification
1
2
Technical&Justification
1
1
Figures,&Tables,&References
1
2
Total&for&Science&Plan
3
5
Additional&Required&Sections&A&subject&to&page&limits
Summary(of(Existing(Programs
1
1
Additional&Required&Sections&A&NOT&subject&to&page&limits
Observation(Summary(Table
Modification(of(Proprietary(Period
Summary(of(Duplicate(Observations
Summary(of(Scheduling(Constraints/Targets(of(Opportunity

Large
hours&≥&100&&

3
2
3
8
1

Table 4: Page limits for Cycle-14 proposals.

5.4 Proposal Contents
5.4.1 The Science Plan
All investigators should recognize that the peer review process (§7.1) uses external scientists,
many of whom are not experts in your subfield. Reviewers are selected such that their expertise
reflects the proportional mix of proposals submitted in previous cycles. Proposals should be
written for a knowledgeable, but broad-based, audience. Proposals will be evaluated according
to the criteria listed in §7.2.
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5.4.1.1 Science Justification
Proposals must include a clear statement of observing goals and describe the importance of the
proposed project to the astronomical sciences and as a component of the final legacy of the
Spitzer mission. It should address why the Spitzer capabilities are uniquely important in
advancing knowledge in the proposed area of research. The science justification and its
underlying rationale should be readily comprehensible to broad-based scientists. It must include
a justifiable and reasonably accurate request for observing time and must be based on the
resource estimates calculated with Spot, the SSC proposal planning and submission software.

5.4.1.2 Technical Justification
The technical justification must include a description of the proposed observing strategy and
information about target selection. For all observations, the technical justification must include
quantitative descriptions of the required sky/target position(s), expected target flux density or
surface brightness, required sensitivity/depth (1-sigma noise or S/N ratio), wavelength(s), and
coverage strategy (including redundancies). The technical justification should also show that the
proposers have checked the sky background brightness and saturation issues for their
observations and provide the maximum expected flux densities or surface brightness in the fields
of view. The proposal must define the photometric accuracy needed and any special calibration
requirements.
All flux densities and surface brightness estimates should be provided in the following
units:
Point Sources
Extended Sources

micro-Jy, milli-Jy, or Jy
MJy/sr

Telescope and scheduling constraints placed by investigators on proposed observations must
include a compelling scientific justification (§4.4.2). Observers proposing observations of bright
objects (§4.4.4) should discuss their impact in the technical justification.
In all cases, the target list for Spitzer observations must be adequately justified and explained.
Investigators should describe why the proposed targets were selected, and any assumptions made
about their targets and/or sample. For proposals requesting time for targets that have yet to be
discovered, the provenance of the targets must be explained. The reviewers must be able to
determine the likelihood that the targets will be discovered and that the proposers have access to
the necessary data.
Statistical programs (§3.4) should be explicitly declared and described in the technical
justification.
The technical justification should include a data analysis plan. A description of the IRAC
pipeline can be found in Spitzer Observer’s Manual-Warm Mission and the IRAC Instrument
Handbook.
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The technical justification should include a description of how the proposers have validated their
particular technical strategy, e.g. from previous observations or modeling. This should be
described in detail.

5.4.1.3 Figures, Tables and References
Figures, tables and references that support the science justification and technical sections should
be included in the Science Plan. Figure captions and tables may be listed in 10-point font (rather
than 12-point). The Observation Summary table required for all observing proposals is not
included in this page limit (it is a separate section, see below). Color figures or tables can be
included but should be legible when reproduced in black-and-white. They should be of adequate
size to be comprehended by a reader. The PDF file size limit for submission is 10 megabytes so
extremely large or complex color figures may not be acceptable.

5.4.2 Other Contents
5.4.2.1 Summary of Existing Programs
Proposers must explicitly summarize their current involvement as a Principal Investigator or
Technical Contact on existing Spitzer Space Telescope research programs. This applies to the PI
and principal Co-Is on the proposal. The proposer should indicate the status of each Spitzer
GTO, GO, Legacy, Exploration Science, DDT, Archival or Theoretical program and any
publications resulting from the program(s). For observing programs, include the status of the
data analysis effort.
Proposers that are the PI/Technical contact for multiple Spitzer programs are not required to
provide a detailed status for every program. They should provide a summary that includes the
number of programs, overall status (e.g. 75% observed, 50% data analysis complete, 20 papers
published, 20 papers submitted, etc.) that will allow the reviewers to understand the state of the
programs. This section should be a maximum of one page in length.

5.4.2.2 Observation Summary Table
An Observation Summary Table is required for all proposals. The Observation Summary Table
is not subject to the proposal page limits. For each proposed observation, the table must include
all target position(s), imaging array(s) (e.g., 3.6 and/or 4.5 microns), integration time per array,
and estimated source flux. The background flux, sensitivities and depth reached should be
included in the technical justification and can optionally be included here. Low-impact targets of
opportunity should be identified in the table. All flux densities and surface brightness estimates
must be provided in correct units:
Point Sources:
Extended Sources:

micro-Jy, milli-Jy, or Jy
MJy/sr

As discussed in §3.4 the SSC will accept ‘statistical programs’ in which a specific number of
observations are required for the science but the set of observations required is not unique. For
example, if your program requires observations of 10 targets in your sample and you have 20
targets total in the sample the proposal can be submitted with AORs specifying observations of
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20 targets but time is only requested to observe 10 of them. All of the targets should be
described in the Observation Summary Table for all proposal types and sizes.
A Perl script that parses information from the AOR file into a format that can be reformatted into
a table is available in the Proposal Kit.

5.4.2.3 Modification of Proprietary Period
If a proprietary period of other than the default for the proposal type is requested, this should be
specified here. There is a field specifying the number of days in the proprietary period in the Spot
proposal submission tool. Any modifications should also be entered there. Note that each
observation (AOR) has its own proprietary period. This means that the AORs within a program
are, as their proprietary periods expire, released to the public regardless of how many unobserved
AORs remain in the program.

5.4.2.4 Summary of Duplicate Observations
Briefly summarize the justification for any proposed duplicate observations. The details should
have been provided in the Science Plan.

5.4.2.5 Summary of Scheduling Constraints/Targets of Opportunity
Briefly summarize the justification for any proposed scheduling constraints. The details should
have been provided in the Science Plan. Also provide a summary of any ToO scheduling issues.

5.5 Submission of Proposals
Proposals must be submitted to the SSC electronically through Spot, the Spitzer observation
planning software (Spot; see §4.2), and must be consistent with the page and format guidelines
listed throughout this section. The PDF file must be created using one of the templates available
at the Proposal Kit website. Proposals using the old templates will be rejected. Detailed
instructions on using the software are available in the Spot User’s Guide, and are summarized
below.

5.5.1 Submitting Your Proposal for the First Time
1. Download Spot from the Proposal Kit section of the SSC website
(http://ssc.spitzer.caltech.edu/warmmission/propkit/) and install it on your host machine.
Use the S19 version of Spot, which was released September 9, 2011. Turn on the autoupdate feature to make sure you get the relevant updates. If you use Linux and JAVA
version 1.8, we recommend you download Spot for Linux from the Proposal Kit
webpage and do a clean re-install, then let Spot auto-update (Spot Main Toolbar:
Options -> Use Automatic Spot Version Update).
2. Download a Cycle-14 proposal template from the Proposal Kit website and use it to
create the proposal PDF file.
3. Start up Spot and open the Proposal Tool (Tools -> Proposal Tool).
4. Enter the coversheet information or load any previously generated cover sheet
information file, into the Proposal Tool.
5. Select the correct Proposal Type: GO or Snapshot
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6. Enter the total observing time required.
7. Make sure you have updated the proprietary period, if necessary.
8. Load the AORs that comprise your program. Make sure you have updated the resource
estimates for the AORs.
9. For low-impact ToO proposals, check the Target of Opportunity box.
10. Click on the SUBMIT Menu in the Proposal Tool and select ‘Submit proposal to SSC.’
11. Prior to the proposal submission deadline, proposals can be modified by using the
‘Update Proposal at SSC’ option.
12. The proposal PDF file, cover sheet, and any accompanying AORs that reside at the SSC
at the time of the proposal submission deadline shall be defined to be the final version of
the proposal.
Note that neither NASA nor JPL/Caltech will be responsible for any cost incurred in preparing or
submitting a proposal.

5.5.2 Updating Your Submitted Proposal
At any time during the Call for Proposals you may modify any aspect of your submitted
proposal, except proposal username and password. You can submit a revised science plan,
updated set of AORs, and/or corrected coversheet information.
1.
2.
3.
4.

Start up Spot.
Load in new/revised set of AORs if you are updating the AORs.
Open the Proposal Tool under the Tools menu in Spot.
Load in the coversheet file saved from your earlier submission (i.e., filename.cs) by
clicking on File-> Open Proposal.
5. Make any desired changes to the coversheet information. Be sure the ‘Hours Requested’
is accurate and that the Proposal Tool is pointing to the proper justification file (if
submitting an updated file).
6. Click on the ‘Submit’ menu item and then ‘Update proposal at SSC.’
7. Enter your password and email address when requested.
8. If you made any changes to the coversheet information, Spot will again require you to
save your coversheet file.
9. Spot will inform you when it has successfully transferred your updated proposal to the
SSC. You will also receive an email confirmation.
10. You may submit as many updates as needed prior to the proposal deadline. The software
will automatically reject submissions after the deadline and Spot will return an error
message.
Modifications to proposals are not permitted after the deadline. Please proofread your proposal
before the final submission.
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6 Eligibility & Funding Support
Investigators worldwide, subject to NASA Grant Circular 12-01 (below), are eligible to submit a
proposal in response to the Spitzer Space Telescope Cycle-14 Call for Proposals.

6.1 Who May Submit a Proposal?
This solicitation for proposals is open to investigators of any nationality, subject to NASA Grant
Circular GIC 12-01 (§6.2). Each proposal must identify a single individual who will serve as
Principal Investigator (PI) and will be responsible for the scientific and administrative conduct of
the project. The PI for GO proposals may have any institutional affiliation. There is no limit to
the number of Co-Investigators (Co-Is) that may appear on a proposal. The PI may designate a
Technical Contact for purposes of communications with the SSC Science User Support Team.
Graduate students and post-docs can apply for Spitzer time as principal investigators. Before
applying they should check with their advisors regarding any specific requirements of their home
institution regarding proposal submission.

6.2 NASA Grant Circular GIC 12-01
This rule effectively says that no proposals may be accepted that include ONLY investigators
from Chinese institutions or Chinese plus U.S. institutions, i.e. a bilateral program between the
US and China. Proposals can be accepted that include investigators from institutions in China,
the US and investigators from institutions in another country. The text below is extracted from
NASA GIC 12-01 and describes the rules which apply to possible US/China observing
proposals.
An Assurance of Compliance with The Department of Defense and Full-Year Appropriation Act,
Public Law 112-10 Section 1340(a); The Consolidated and Further Continuing Appropriation
Act of 2012, Public Law 112-55, Section 539; and future-year appropriations herein after
referred to as “the Acts”, whereas:
(1) NASA is restricted from using funds appropriated in the Acts to enter into or fund any grant
or cooperative agreement of any kind to participate, collaborate, or coordinate bilaterally with
China or any Chinese-owned company, at the prime recipient level and at all subrecipient levels,
whether the bilateral involvement is funded or performed under a no-exchange of funds
arrangement.
(2) Definition: “China or Chinese-owned Company” means the People’s Republic of China, any
company owned by the People’s Republic of China, or any company incorporated under the laws
of the People’s Republic of China.
(3) The restrictions in the Acts do not apply to commercial items of supply needed to perform a
grant or cooperative agreement.
(4) By submission of its proposal, the proposer represents that the proposer is not China or a
Chinese-owned company, and that the proposer will not participate, collaborate or coordinate
bilaterally with China or any Chinese-owned company, at the prime recipient level or at any
subrecipient level, whether the bilateral involvement is funded or performed under a noexchange of funds arrangement.
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6.3 Funding Support
No NASA funding is expected to be available to support direct data analysis awards in Cycle-14.
Cycle-14 programs are eligible for page charges, paid directly by the SSC, for publishing work
directly related to the results from the observing program. The paper must be accepted and the
funding requested, via an email to the Spitzer Helpdesk, while the Spitzer Science Center is still
operating.
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7 Proposal Evaluation and Selection
Spitzer Space Telescope Cycle-14 programs will be selected through a competitive peer review
process.

7.1 Peer Review
External science reviewers will evaluate proposals received by the submission deadline. The
reviewers will be members selected at large from the astronomical community. Topical science
panels (Extragalactic and Galactic/Planetary) will review all proposals. Highly ranked proposals
will be forwarded to the Time Allocation Committee for final review. The Time Allocation
Committee is composed of the panel chairs and one or two at-large members. The TAC will
provide recommendations on allocations to the SSC Director who will make the final selection.
Proposals will be provided to reviewers as PDF files. It is the responsibility of the proposer to
ensure that their PDF file is legible when opened with Acrobat Reader or other PDF viewers.
Based on the preliminary grades, proposals with low average grades are triaged and are not
further considered in the review process. After programs are selected, scheduling priorities are
assigned based on the final proposal rankings.
The SSC works to avoid conflicts of interest throughout the review process to the extent
possible.

7.2 Evaluation Criteria
External science reviewers will evaluate proposals received by the submission deadline. The
evaluations will be based on the criteria listed in this section. The criteria are listed in
descending order of importance.
(1)
The overall scientific merit of the proposed investigation and the importance of the
program as a component of the final legacy of the Spitzer mission. Support of other NASA
missions and responsiveness to the priorities of the 2010 Decadal Review of Astronomy and
Astrophysics will be considered as part of the scientific merit.
(2)
The extent to which the proposed investigation requires the unique capabilities of the
Spitzer Space Telescope.
(3)

The technical feasibility and robustness of the proposed observations.

(5)
The extent to which the observations can be accommodated within routine Spitzer
operations and the extent to which the overall science program enables an efficient use of the
observatory.
(6)

The long-term archival value of the proposed observations.
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7.3 Proposal Selection
The Spitzer Science Center (SSC) will organize the Science Review Panels and the Time
Allocation Committee. The end result of the review process is a list of recommended programs
that is provided to the SSC Director, who is the selection official for all Cycle-14 programs.
Upon selection by the SSC Director, observing programs are entered into the Spitzer
observations database for execution as part of Cycle-14.

7.4 Proposal Confidentiality
Proposals submitted in response to this Call for Proposals will be kept confidential to the extent
allowed by the review process. For approved investigations only, the SSC will make the titles,
investigator names, and abstracts publicly available after the selections are announced. The
remainder of the approved proposal, and the entirety of proposals not selected, shall remain
confidential. In addition, AORs from the approved observing investigations will be incorporated
into future versions of the Reserved Observations Catalog and will also be available to download
from the Spitzer science operations database using Spot, Leopard and the Spitzer Heritage
Archive.
If a proposal contains proprietary information that should not be used and/or disclosed for any
purpose other than the proposal evaluation, it should be clearly marked by placing the following
legend on a separate page that does not count against the proposal page limit:
“NOTICE: The information (data) contained in [insert page numbers or other identification] of
this proposal constitutes a trade secret and/or information that is commercial or financial and
confidential or privileged. It is furnished to the Government and the Jet Propulsion
Laboratory/California Institute of Technology (“Institute”) in confidence with the understanding
that it will not, without permission of the proposer, be used or disclosed other than for evaluation
purposes; provided, however, that in the event a contract (or other agreement) is awarded on the
basis of this proposal, the Government or the Institute shall have the right to use and disclose this
information (data) to the extent provided in the contract (or other agreement). This restriction
does not limit the Government’s or Institute’s right to use or disclose this information (data) if
obtained from another source without restriction.”
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8 Contacting the Spitzer Science Center (SSC)
Questions about any aspect of the Spitzer Space Telescope, including the Call for Proposals, may
be submitted electronically to the Helpdesk at:

help@spitzer.caltech.edu
Contacting the Helpdesk is the fastest and most efficient way to get the answer to your question.
The mailing address is:

Spitzer Science Center
California Institute of Technology
Mail Code 314-6
1200 East California Boulevard
Pasadena, CA 91125 USA
The main telephone number is:

Phone:

+1-626-395-8000

The science community should consult the Spitzer Science Center Website at:

http://ssc.spitzer.caltech.edu/
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9 Publication and Dissemination of Science Results
The publication and dissemination of science results is critical in assessing the success of the
Spitzer Space Telescope mission, and in assessing how effectively it meets the goals of NASA’s
strategic plans in space science. The Spitzer research community is reminded of the important
responsibility inherent in utilizing this national resource, and in sharing the scientific results with
the general public. In particular, investigators with potentially important and newsworthy results
should contact the SSC as early as possible to help NASA plan appropriate news releases.

9.1 Science Publications
It is expected that scientific results obtained through Spitzer observations, archival research, and
theory investigations will be published in the scientific literature. All publications based on
Spitzer data or theory investigations must carry an appropriate acknowledgement. Investigators
should consult the SSC website for the appropriate acknowledgement template(s).
(http://irsa.ipac.caltech.edu/data/SPITZER/docs/spitzermission/publications/ackn/)
In papers describing Spitzer results, investigators should provide reference(s) to seminal papers
describing the telescope, including the relevant science instruments. These references are posted
on the SSC website (http://ssc.spitzer.caltech.edu/spitzermission/publications/). Moreover, the
SSC advises investigators to accurately trace the original heritage of any Spitzer archival data.
In particular, scientific results based on data from the Legacy Science Program should cite
appropriate references to the appropriate program
(http://ssc.spitzer.caltech.edu/spitzermission/observingprograms/legacy/).

9.2 Press Releases
Researchers who receive Spitzer Space Telescope observing time and/or NASA funding support
are strongly encouraged to release Spitzer-related and newsworthy information through NASA
channels. This does not preclude news releases by other institutions, although such parallel
releases must be coordinated with NASA. The SSC utilizes the public affairs resources of
NASA and the Jet Propulsion Laboratory to maximize the impact of discoveries and newsworthy
items resulting from Spitzer research investigations. NASA has “first right of refusal” for such
items and has a policy to distribute all information and news fairly and equitably. This policy
also means that exclusive news releases are not supportable.
Scientists with potentially newsworthy observations should contact the SSC Director’s Office via
the Helpdesk (help@spitzer.caltech.edu). Spitzer investigators should initiate such contact well
before the expected publication of those results, in order to allow the SSC, JPL, and NASA to
prepare press releases and supporting materials. The contact may either be initiated by the
Principal Investigator of the Spitzer investigation, or through the public affairs office of their
home institution. For a potential press release, the SSC and NASA will coordinate with the PI
and/or institutional public affairs office in the preparation of a draft news release and other
supporting materials. In general, the press release date will be timed to coincide with acceptance
of the research for publication in a science journal, or presentation at a major astronomical
meeting. For additional information on Spitzer public affairs, including guidelines on what may
constitute a newsworthy result, consult the ‘Got News’ link on the SSC website.

29

Spitzer Cycle-14 Call for Proposals

v2.0

15 February 2018

10 Cycle-14 Checklist
1. Read this Call for Proposals.
2. Download the Warm SOM from the Proposal Kit section of the SSC website
(http://ssc.spitzer.caltech.edu/warmmission/propkit/) to obtain additional details about the
telescope and the IRAC Post-Cryo Mapping AOT.
3. Download and install the v19 version of Spot, the Spitzer proposal planning and
submission software package, available in the online Proposal Kit, to your host machine.
Allow Spot to auto-update to the latest version. If you use Linux and JAVA version 1.8,
we recommend you download Spot for Linux from the Proposal Kit webpage and do
a clean re-install, then let Spot auto-update (Spot Main Toolbar: Options -> Use
Automatic Spot Version Update).
4. Download and read the Spot User’s Guide and learn how to create and edit an
Astronomical Observation Request (AOR), the fundamental unit of Spitzer observing.
5. Download and read the Spitzer Space Telescope Observation Planning Cookbook, also in
the Proposal Kit, to see examples of typical observations.
6. Use Spot to create, edit and save AORs.
7. Be sure that your proposed observations do not duplicate existing Spitzer Space
Telescope observations by consulting the Reserved Observations Catalog or searching
the Spitzer database with Leopard. If duplicate observations are proposed be sure you
have provided a strong scientific justification.
8. Contact the electronic Spitzer Helpdesk (help@spitzer.caltech.edu) for assistance, if
needed.
9. Prepare your observing proposal according to the guidelines listed in §5.2. Templates for
preparing the PDF proposal attachment in Latex and Microsoft Word formats are
available in the online Proposal Kit. Proposals submitted that do not utilize the Cycle-14
templates will be rejected outright.
10. Note the evaluation criteria listed in §7.2.
11. Follow the steps described in §5.4.1.3 to electronically submit your proposal, cover sheet,
and accompanying AORs to the SSC prior to the deadline of 2:00pm PDT, Friday,
March 23, 2018.
12. If you experience computer or Internet problems just prior to the deadline such that you
are not able to submit your proposal by 2:00 pm, do not wait until after the deadline to
contact us. Contact the electronic Spitzer Helpdesk (help@spitzer.caltech.edu), if
possible or call us immediately at 626-395-8000 (SSC central phone line) and let us
know.
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11 Appendix A: Special Telescope Overheads
Resource limitations in terms of staff during the warm mission preclude continued support
for medium and high impact ToO programs, late ephemeris updates for Solar System
observations, and IERs as part of GO proposals. These observations may be submitted via
DDT proposals. The Spitzer project may support a limited number of such observations
annually as permitted by available resources.
Special overhead burdens are applied to high/medium-impact Targets of Opportunity (ToO).
This special overhead is added to the normal overhead applied to each Astronomical Observation
Request (AOR) computed by Spot, the software required for Spitzer observation planning and
proposal submission. It accounts for the time required to prepare for the observation and to
return the Telescope to its nominal schedule. As described in the Spitzer Space Telescope Warm
Mission Observing Rules, the special overhead is intended to reflect the observing time lost in
other programs as a result of executing the relevant observation(s).
In evaluating ToO proposals, peer reviewers will assess the value of observations with special
overhead burdens against other proposed observations. Proposals must include these overheads
in the total requested observation time. The relevant special overheads during the warm mission
are:
High-Impact Target of Opportunity: 6.5 hours
This overhead will be applied to the first AOR in a group, chain or sequence of AORs to be
executed consecutively during a single observing session on a single ToO with one science
instrument. For observations that are constrained with a follow-on constraint, the overhead must
be applied to every AOR individually. The group, chain or sequence constraints mean that
observations can be scheduled contiguously and therefore have less impact on the schedule than
those constrained with a follow-on constraint.
Medium-Impact Target of Opportunity: 2.6 hours
This overhead will be applied to the first AOR in a group, chain or sequence of AORs to be
executed consecutively during a single observing session on a single ToO. For observations that
are constrained with a follow-on constraint, the overhead must be applied to every AOR
individually.
These overheads must be specified using Spot when the AORs for the proposal are created.
From within the relevant AOR dialog click the Special … button and select the overhead from
the list. Spot will calculate the required time and add it to the Total Duration returned on the
main Spot AOR page.
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12 Appendix B: Acronyms and Abbreviations
AOR
AOT
AR
Co-I
CP
CVZ
DDT
FAQ
FOV
GO
GTO
IER
IRAC
JPL
Legacy
NAIF
NASA
PCRS
PDF
PDT
PI
ROC
SHA
SOM
SSC
TAC
TESS
ToO
TR
Warm SOM

Astronomical Observation Request(s)
Astronomical Observation Template(s)
Archival Research
Co-Investigator
Call for Proposals
Continuous Viewing Zone
Director’s Discretionary Time
Frequently Asked Questions(s)
Field of View
General Observer(s)
Guaranteed Time Observer(s)
Instrument Engineering Request(s)
InfraRed Array Camera
Jet Propulsion Laboratory
Frontier Legacy
Navigation and Ancillary Information Facility
National Aeronautics and Space Administration
Pointing Calibration and Reference Sensor
Portable Document Format
Pacific Daylight Time
Principal Investigator
Reserved Observations Catalog
Spitzer Heritage Archive
Spitzer Observer’s Manual
Spitzer Science Center
Time Allocation Committee
Transiting Exoplanet Survey Satellite
Target(s) of Opportunity
Theoretical Research
Spitzer Observer’s Manual – Warm Mission

32

